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Digital Video
Recording
and Editing

After completing this chapter, you will be able to:

� Understand how digital video recording works and realize why movies play back better

on faster computers

� Consider the options available for recording and editing digital video with Windows

or a Macintosh

� Know how to acquire the necessary hardware and/or software to setup your computer to

record digital video

� Edit digital video using QuickTime Pro for Windows or QuickTime Pro for the Macintosh

� Conserve disk space by compressing the digital video recording

� This chapter is a tutorial on recording and editing digital video clips on Windows and Macintosh computers. If your

computer does not have a video capture device installed, you will not be able to make an actual

recording; however, you will still be able to complete the digital-video-editing tutorial.

How Digital Video Works
Figure 35-1 shows an artist’s impression of how video gets digitized. The basic process is
fairly easy to understand. You connect a video source, such as a camera or a VCR, to
your computer’s video capture device. When you tell your computer to start recording,
the video capture device converts the incoming video signal into a stream of numbers
that represent the video signal digitally. The digital video stream contains an enormous
amount of data. To conserve space on your hard disk when you save the movie, the
video gets compressed, down to as little as 1/200 of its original size. One or more of the
video compression schemes explained in Table 35-1 may be used.

On playback, the computer’s microprocessor must read the encoded information, decode
it, and route the video to the screen and the soundtrack to the waveform audio device.
Because some computers are slower than others, the recording process uses a clever
scheme in which audio frames are interleaved with the video. The soundtrack plays
uninterrupted because the audio always takes priority. Then the computer shows as
many frames of video as it has time to process. If it is too late to show a given frame, your
computer just skips it and goes on to the next frame. Because the audio has priority, you
get the aural illusion of uninterrupted playback. In this chapter, you will learn how to
record and compress video for playback on slow as well as fast computers.

35

Figure 35-1 An artistic
impression of how micro-
computers play digital
video recordings.

Artwork provided courtesy of
Intel, Inc.
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Table 35-1 Video Compression Schemes

MethodMethodMethodMethodMethod How It WorksHow It WorksHow It WorksHow It WorksHow It Works

YUV subsampling Divides the screen into little squares and averages color values of the pixels in each square.

Delta frame encoding Shrinks data by storing only the information that changes between frames; for example, if the background scene does not
change, there is no need to store the scene again.

Run length encoding Detects a “run” of identical pixels and encodes how many occur instead of recording each individual pixel.

Preparing Your Hard Drive
Before you can record video to your hard disk drive, you must make sure there is enough
space to hold the recording. A rule of thumb is to have 15 MB of free disk space for every
minute of video you plan to record. This will get compressed later on to save space, but
you need enough free disk space to hold the raw video at first.

To complete the exercises in this chapter, you should have at least 20 MB of free disk
space. If you do not have that much available, free some now.

Recording the Video
To make a digital video recording, you must first connect a video source, such as a
camera or a VCR, to your computer’s video capture device. Then you run the recording
software that came with your video capture device. If your computer does not already
have a video capture device, the author suggests that you consider purchasing one of
the products recommended in the video capture section of Chapter 35 at the Multilit
Web site.

One of the most popular video capture devices is Logitech’s QuickCam, which comes in
several versions ranging in price from $49.95 to $149.95. Figure 35-2 shows the USB

Figure 35-2 The Logitech QuickCam Pro.

• Tilt/swivel base
• includes built-in clamp

Optional lens pack •
Now available •
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version, which the author uses for videoconferencing and video capture on both Windows
and Macintosh computers. The author purchased the USB version of the QuickCam
because of the cross-platform capabilities that enable you to connect it to any Windows
or Macintosh computer with a USB port. If your computer does not have a USB port,
you can purchase a parallel port version of the Logitech QuickCam, or you can consider
installing one of the video capture cards recommended at the Multilit Web site.

To record video with the QuickCam, you follow the steps in Table 35-2. If you have
some other capture device, the process will be similar. If you do not have a video
capture device, skip to the next part of this chapter, which will teach you how to
create and edit digital video clips. You do not have to own a video capture device in
order to edit digital video.

Figure 35-3 The QuickCam Format settings.

Table 35-2 How to Record Digital Video

WindowsWindowsWindowsWindowsWindows MacintoshMacintoshMacintoshMacintoshMacintosh

� Connect your video source to your computer’s video capture device; in
this example, plug in the Logitech QuickCam.

� Get your computer’s video recording software running; in this
example, use the Start button’s Programs menu to run the Logitech
QuickCam software.

� Click the movie camera icon to put the software into movie recording
mode.

� Click the Settings tab, then click Format; the Format settings appear
as illustrated in Figure 35-3.

Figure 35-5 The QuickMovie record window.

� Connect your video source to your computer’s video capture device; in
this example, plug in the Logitech QuickCam.

� Get your computer’s video recording software running; in this
example, use the Finder to go to the Logitech folder on Macintosh HD,
and run the QuickMovie software.

� When QuickMovie asks what filename to save the movie as, type in a
filename, such as MyFirstMovie.

� The record window will appear, as illustrated in Figure 35-5.

Click here to switch to •
playback mode •
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Playing the Video
After you record the video, you will want to play it back. Click the Play button to
rehearse the video. If the video plays back jerkily, you have problems. Here is what you
can do about them:

� Try lowering the color depth. If you are trying to record millions of colors, for example,
set the color depth to thousands of colors instead.

� Try reducing the dimensions of the recorded video. If you are recording at 640 by 480,
for example, reduce the dimensions of the recorded video to 320 by 240 or 160 by 120.
Your computer may not be fast enough to record larger screen sizes.

� Defragment your hard disk drive. Your computer may have come with its own
defragmenting software; to find out, follow these steps:

Table 35-2 How to Record Digital Video (continued)

WindowsWindowsWindowsWindowsWindows MacintoshMacintoshMacintoshMacintoshMacintosh

Figure 35-4 The QuickCam Viewer. Figure 35-6 The QuickMovie playback window.

� For starters, choose the smallest image size, and set the number of
colors to thousands. You can try increasing these settings later, if
your computer is able to record at higher settings.

� If you want to record sound along with the movie, click the sound
recording button on.

� To start recording, press the Record Movie button.

� When you are done recording, press the Stop button.

� After a few seconds, the recorded movie will appear in a QuickCam
Viewer window, as illustrated in Figure 35-4.

� To adjust the size of the recording window, pull down the Settings
menu and choose Sizes. For starters, choose quarter screen. You can
try increasing these settings later, if your computer is able to record at
higher settings.

� To start recording, press the Record button.

� When you are done recording, press the Stop button.

� To play the movie back, click the button in the lower-left corner of the
record window to switch the view to playback.

� Playback controls will appear beneath the movie, as illustrated in
Figure 35-6.

Click here to switch •
back to record mode •
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� If you have Windows, click the Start button, choose Help, click the Index tab, and
find the topic defragment.

� If you have a Macintosh, pull down the Finder’s Help menu, choose Help Center,
search for Hard Disk, and follow the links to repair or improve hard disk
performance.

� If your computer does not contain a built-in defragmenter, follow the Multilit Web
site links to the Norton Utilities, which contain hard disk maintenance software
for both Windows and Macintosh computers.

Saving and Compressing the Video
After you play back the movie to make sure it recorded the way you want it, you need to
save it. The QuickCam software gives you the option to compress the video when you
save it. You can save the video in a wide range of formats, depending on its purpose and
intended audience. To save and compress the video, follow the steps in Table 35-3.

Table 35-3 Saving and Compressing the Video

WindowsWindowsWindowsWindowsWindows MacintoshMacintoshMacintoshMacintoshMacintosh

� If the QuickCam Viewer is not already displaying the video you want
to compress, click the Images tab of the QuickCam window, then
double-click the video to open it.

� Click the File icon in the QuickCam Viewer; the Save As dialog appears.

� In the File Name field, type the name you want the compressed video
to have. For your first capture, assuming your hard drive is C, call the
file C:\multilit\MyMovie

� Click the Compress button; the Video Compression dialog appears as
illustrated in Figure 35-7.

Figure 35-7 The Video Compression dialog.

Figure 35-8 The Video Compression window.

� Pull down the Compressor menu and click to select the compressor
you want to use. For this example, choose Cinepak. For help selecting
the compressor best suited to your application, consult Table 35-4
and follow the Multilit Web site links to Codec Central.

� If you are targeting a specific playback medium, check the Data Rate
box, and enter the device’s data rate. Enter 150 if you want the movie
to be able to play back smoothly on slower computers as well as fast
ones. Higher data rates will improve playback on faster computers,
but beware that file sizes will be larger.

� Click OK to close the Video Compression dialog.

� Click SAVE to begin saving the compressed video. A status indicator
will keep you informed as to the progress of the compressor.

� If QuickMovie is not already displaying the video you want to
compress, pull down the QuickMovie File menu, choose Open, and
open the video you want to compress.

� Pull down the File menu and choose Compress Movie.

� Type the name you want to save the compressed movie as into the
dialog box, then press the New button.

� The Video Compression window appears, as illustrated in Figure 35-8.

� Use the Compressor menu to select the compressor you want to use.
In this example, choose Cinepak. For help selecting the compressor
best suited to your application, consult Table 35-4 and follow the
Multilit Web site links to Codec Central.

� If you are targeting a specific playback medium, check the Limit Data
Rate box, and enter the device’s data rate. Enter 150 if you want the
movie to be able to play back smoothly on slower computers as well
as fast ones. Higher data rates will improve playback on faster
computers, but beware that file sizes will be larger.

� Click OK to begin saving the compressed video. A status indicator will
keep you informed as to the progress of the compressor.
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Choosing a codec may be your hardest decision. The comparison of codecs in
Table 35-4 may make this decision a little easier. For more detailed information about
video codecs, follow the Multilit Web site links to Codec Central.

Table 35-4 Video Compression Codecs

Name of CodecName of CodecName of CodecName of CodecName of Codec Purpose of CodecPurpose of CodecPurpose of CodecPurpose of CodecPurpose of Codec

Apple Animation, Apple None Lossless storage, but inefficient; see Photo JPEG

Cinepak Medium-quality CD-ROM video, works on older computers; the most universal choice

H.261 Low-quality videoconferencing

H.263 Medium-quality videoconferencing

Intel Indeo 3 Medium-quality CD-ROM video, works on older computers

Intel Indeo Interactive High-quality CD-ROM video; requires faster computers

Motion JPEG General-purpose video editing and storage

Photo JPEG When used at 100% as a storage/transfer format, it creates significantly smaller files than animation

MPEG-1 High-quality CD-ROM video; requires special hardware or fast computer

MPEG-2 High-quality DVD-ROM video; requires special hardware or fast computer

MPEG-4 High-quality Web-based video

Sorenson High-quality video intended for publication on the Web and CD-ROM on newer computers

Editing the Video
To edit video, you use a digital video editor. Video-editing software is available in a wide
range of prices, from $29.99 for the Apple QuickTime Pro editor to thousands of dollars
for more advanced editors that use special-purpose hardware to achieve a wide variety of
video special effects. This tutorial teaches you how to edit video with the QuickTime Pro
editor. Do not underestimate the power of QuickTime Pro, however; it can do a lot of
your everyday video editing, even though it does not cost a lot. Follow the links at the
Multilit Web site if you want to learn about other, more expensive editors.

QuickTime Pro is available for download from the Apple QuickTime Web site. If
your computer does not already have a digital video editor installed and you want to
download Apple QuickTime Pro, go to www.apple.com/quicktime and follow the links
to download Apple QuickTime Pro. When this book went to press, the cost of
purchasing a key to unlock QuickTime Pro’s video-editing features was $29.99. Follow
the on-screen instructions to pay this fee and unlock the powerful video-editing features
in QuickTime Pro.

QuickTime Pro lets you cut, copy, and paste segments of video, much like you can cut,
copy, and paste text with a word processor. Follow these steps:

� If you do not already have QuickTime Pro running, double-click its icon to get it
running now.

� Pull down the File menu, choose Open Movie, and open the movie you want to edit. In
this example, open the movie called Moonland in the Movies directory of the Multilit CD.

Show-Me Movie:
“Digital Video Editing”
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� Click the Play button and listen carefully to the start of your recorded video. It
probably contains frames you would like to cut out. You can do this with the slider and
the Selection Start and Selection Stop markers, as illustrated in Figure 35-9.

� In this example, pretend that you want to cut out all of the video up to the point at
which Neil Armstrong speaks his famous words, “That’s one small step for man, one
giant leap for mankind.”

� Use your mouse to drag the slider to the very start of your video (it is probably there
already, but check to make sure).

� Click the Play button to start the video, and play up to the point just after you hear the
words “The eagle has landed.”

� Drag the Selection Stop marker to the spot between “The eagle has landed” and
“That’s one small step.” The spot you want is about 23 seconds past the start of
the video.

� Leave the Selection Start marker at the beginning of the video. Notice how the slider is
grayed out between the Selection Start and Stop markers. The gray area represents
the video you are about to cut.

� Drag the slider to the Selection Stop marker you just set, click Play, and listen carefully.
Does it start exactly where you want? If not, you marked too much or too little to cut.
Adjust your Selection Stop marker accordingly. Repeat this step until you have the
Stop marker exactly where you want it.

� Pull down the Edit menu and choose Cut, or press ∏-X or ±-X. Press the Play
button, and you will find that the segment you marked has been cut out of the video.

Figure 35-9 The QuickTime Pro Window.

• Selection Start Marker

• Selection Stop Marker

• Playback Slider

• Click here to display or hide
more controls
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If there is video at the end of the recording you want to cut, you can repeat this process
by setting the Mark In and Mark Out points at the end of the clip. With practice, you will
get very good at this. Later on, you can experiment with pasting sequences you have cut
into different places in the video to make things happen in a different order than when
you recorded them. When you are finished editing the video, pull down the File menu,
choose Save As, and save the movie under the filename of your choice.

e x e r c i s e s
1. There is a movie in the Video directory on the Multilit CD called clipvid. When you play it, you will notice that it has

material at the start and at the end that should be cut. Use your video-editing software, such as QuickTime Pro, to
do that. Save the resulting file in your Multilit directory under the name TrimmedClip.

2. Use your video-recording software, such as Logitech QuickCam or QuickMovie, to record a 10-second video clip.
Pull down the File menu, choose Compress File, and choose the option to save the file with no compression in
your Multilit directory under the name uncompressed. Use the File Manager to find out how large the file is.
Now use Logitech QuickCam or QuickMovie to compress the file with the Cinepak compressor at a color depth
of 256 with medium quality. Save the file in your Multilit folder under the filename compressed. How large is
the file now? By what percentage did the Cinepak compressor reduce the file in size, as compared to the size of
the full framed version?


